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Photoshop 7.0 Overview – Selection Tools 
 
Photoshop is a graphics program used to design and edit graphics for both Windows and 
Macintosh platforms.  Photoshop can be used to add special effects to an image, correct color 
and image flaws, and even remove parts of an image from a background.   
 
Photoshop is a very powerful tool and learning the “magic” of Photoshop takes time, practice, 
and experimenting with the different tools in order to learn the program.   This class will focus 
on introducing you to the basic overview of the screen and demonstrating different ways to select 
parts of an image.  
 
Options Bar 
 
The Options Bar is located at the top of Photoshop screen below the Menu Bar.  The fields in the 
Options Bar are context sensitive meaning that when a tool is selected from the toolbox the 
Options Bar will change to reflect options for the selected tool.   
 
The Toolbox 
The Toolbox contains several different tools that can be used to edit or create images.  Position 
the mouse cursor anywhere on the tool icon in the Toolbox and a yellow tool tip will appear 
displaying the name of the tool.   

• To toggle the toolbox off and on choose Window, Tools 
• To move the toolbox click with the mouse in the Title bar of the toolbox and drag it to a 

new location. 
 
Selecting  a Tool 

Select a tool by clicking with the mouse on the tool icon 
in the Toolbox.    A small triangle in the bottom right 
corner of the tool icon indicates additional options or 

Hidden tools that can be chosen..   
 
Click with the mouse on a tool icon from the fly-out menu to select the tool. The shortcut key for 
the tool is displayed on the right-hand side of the tool.  Press the shortcut key at anytime while 
working in Photoshop to switch to the tool tied to the shortcut key pressed.  Press the Shift key + 
the shortcut key to switch between the tools in the hidden or flyout menu. 
 
New View  
At times you may want to look at the same image at different magnifications while editing it.  
You can open the same image in multiple windows and whatever changes you make in one 
window will apply to all windows open for that one particular image.   
 
• Choose   Window, Documents, New Window 
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File Browser 
 
Photoshop 7 offers a new tool called the File Browser where files can be searched and opened 
visually rather than just by filename.   
 
The File Browser is located in the File menu, choose File, Browse.   
 
From the File Browser dialog box you will notice that a “tree” view of your hard drive is 
displayed.  Select a folder and the images in the folder will appear on the right-side of the dialog 
box. 
 
When an image is selected 
from the right-side of the 
dialog box a preview of the 
image will appear on the 
left-side of the dialog box 
beneath the “tree” view of  
your system.  
 
Information regarding the 
images is displayed beneath 
the image preview, such as 
filename, date created, 
image format and other 
information. 
 
The information displayed 
beneath the image preview provides much more information about the image than you see when 
using the File, Open method or when viewing the properties of an image.   
 
Double-click the image to open the image in its own window in Photoshop.  Note, you can also 
drag files from the file browser into the Photoshop main workspace where it will open in its own 
window. 
 
More Options with File Browser 
 
The File Browser can also be used for file management tasks such as, rename files, rename files 
in batch, rank files, remove rank, create a new folder, rotate image previews and several other 
options. 
 



 

K:\Ctss_Dev\class_handouts\summer\photoshop7_selectiontools_rev.doc Page 3  of  17 
© Computer Training and Support Services  

  
Creating and Opening a Canvas 

• To Open a file, choose File, Open and select the file.   
• To create a canvas, choose File, New and select the dimensions for the new canvas. 

 
Resolution:  72 pixels/inch is good for on-screen 
viewing or for web graphics.   
 
300-600 pixels/inch is good for printing images on 
most printers.  
 
1200 pixels/inch or greater should be used for high 
quality printers and images, such as a printing press. 
 
Mode:  The two most common Modes are RGB and 
CMYK.   
 

RGB (Red, Green, Blue) is used as a default in most cases and is good because it is the standard 
for monitor color.    
 
CMYK (Cyan, Magenta, Yellow, Black) is a standard color mode for color printing. 
 
Contents:  Contents is the background color of your document window or canvas.  We will be 
using White as the Content color for most of the class examples.   
 
The Background Color option will fill the document window (or canvas) with the background 
color selected in the Toolbox.   
 
The Transparent option is mostly used for web graphics. 
 
Saving a Photoshop File 

• To save a Photoshop file and preserve all layers, choose File,  Save As, name the file, 
leave the .psd file extension and navigate to the drive and folder for storage.   

• To save a file in a file format that is something other than .psd choose  File,  Save As and 
select the Format option from  the file type and choose Save. 

 
Note:  It is always a good idea to save a copy of the original image before you edit it by choosing  
File, Save As, and select the Copy from the Save Options.   
 
Paint Tools 
 
Selecting Foreground and Background Colors   
The Foreground and Background color chips are located in the toolbox.  The 
Foreground color chip is used to paint, fill selections, and stroke (add a border) areas of an 
image.   The background color chip is used to make gradient colors and at times used as the 
background color when using the erase to background tool.   
 
Tip:  Some filters use foreground and background colors. 
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Foreground Color  
The Foreground Color tool determines which color is used while using the paint tools.  Change 
the Foreground Color by clicking the Foreground Color icon to display the Standard Color 
Picker dialog box.  From the Standard Color Picker dialog box click on a color with the mouse 
pointer and choose OK. 
 
Background Color  
 
The Background color tools is used when erasing the background of the image or when you 
increase the size of the canvas by choosing  Image,  Canvas Size.   
 
Color Picker Dialog Box 
When viewing the Color Picker dialog Box the colors available to 
select from are located in the large square on the left side.    Use the 
Vertical Gradient that is located in the middle of the dialog box to 
select the general color you want to use.  The two color swatches located to the right of the 
Vertical Gradient display the selected color in top color swatch and the color previously chosen 
in the lower color swatch. 
 
BEWARE of  Out-of-Gamut and Non-Web-Safe Colors  
 
Out-of-Gamut 
The out-of-gamut warning, a small triangle appearing to the right of the color swatches in the 
dialog box, signal that the color chosen is not reproducible in CMYK mode, which means it 
cannot be printed without shifting to a different color.  Photoshop provides a sample of the color 
it will shift to in a square directly below the out-of-gamut warning triangle.  Click on the small 
square to select the color or with the dialog box open have Photoshop display how the colors will 
look when printed by choosing  View, Proof Colors. 
 

Swap the Foreground and Background colors by clicking the small curved doubled edged 
arrow located in the top-right corner of the Foreground and Background Color Control Box.   

 
   Reset the Foreground and Background colors to their default color of black and white by 

clicking on the small icon located in the lower- left corner of the Foreground and Background 
Color Control Box. 
 
Using Brushes 
The brushes in Photoshop aren’t only used for painting.  The brushes can be used for drawing 
and selecting as well.  The Airbrush, paintbrush, pencil, line tool and eraser can all be used for 
drawing. 
 
Available options for brushes include changes in the opacity, pressure, blend mode and some 
have fade and wet edges as available options.  
 
Opacity:  Opacity works on a scale of  0-100%.  A setting of 100% Opacity will cover 
everything you paint and you will not be able to see beneath the paint.  Anything less than 100% 
Opacity will allow visibility beneath the painting depending on the Opacity setting. 
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Blending Mode:  There are several Blending Modes available to use when painting on an image.  
For this class, we will be using the Normal Mode.  Normal Mode provides the same effect as 
when you paint on paper or a canvas.   
 
 
Photoshop has preset brush sizes to select from while painting or drawing.   Select the tool from 
the toolbox and choose a brush size and type from the Options Bar. 
 
The Brushes Palette is now located in the Options Bar.   

 
Click on the Pull-down arrow for the brushes to 

display the brush options.   
 
Click with the mouse on the black arrow pointing right 

and select Load Brushes to load additional brushes 
that come with Photoshop. 

 
 
 
 

 
Tip:  The Define Brush tool is now located under the Edit Menu.  Use the Rectangular 
Marquee tool to make a selection and then choose Edit, Define  Brush.    
 
 
Using the Fill Tool 
One of several ways to use the Fill tool is to select it from the Edit 
Menu.  Start by creating a selection on the canvas.  Next, choose  
Edit, Fill and choose an option from the Contents area of the Fill 
dialog box.  Photoshop will use the color in the Foreground and 
Background color chips when selecting Foreground or Background 
color from the Fill Dialog box.     
 
Extra :  Create a pattern and use it as a fill.  Use the Rectangular 
Marquee tool to select a color or pattern you like on a canvas.  
Next, choose Edit, Define as Pattern and assign a name for the pattern.  The Pattern you make 
will now be available to use from the Fill dialog box.   
 
 

Paint Bucket   
 
Tip:  Photoshop 6/7 grouped the Paint Bucket with the Gradient Tool.   
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Move the triangle to 
zoom in or zoom out.   

Zoom Level 

Zoom in or Zoom out 
options 

The Paint Bucket tool is used to fill selected areas or an entire canvas with a fill color. 
 

• Select the Paint Bucket tool from the toolbox. 
• Click in the area where you want to use the fill color. 
• Whatever color is displayed in the Foreground color box will be used to fill the selected 

area.  
• To change the Fill Color click with the mouse on the Foreground Color icon in the 

toolbox and select a different color from the color picker dialog box.  Choose OK when 
finished.  To apply the Fill Color select the Paint Bucket from the toolbox and the 
Foreground Color will be applied to the selected area. 

 
Painting With Gradients   
Give your image a different look by applying a gradient style.  Gradients can be applied 
to selections or to an entire layer.  Select the Gradient tool from the toolbox and then select the 
gradient style from the Options Bar.   

.   
 

1.  
 
• Select a color scheme for the gradient.  There are two ways to select gradient colors: 

1. From the Option Bar select a preset color combination under the Gradient Picker. 
2. From the toolbox select a Foreground and Background color from the color picker.  

• After the gradient style and gradient colors have been selected, position the cursor inside the 
image and left-click and drag across the image or canvas.  

 
Zoom Information 
 
Navigator Palette 
The Navigator Palette is used to zoom in/out of a particular area of an image.   

• Choose   Window, Navigator to display/toggle off  the Navigator Palette 
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Zoom Tool 

The Zoom tool is used to magnify and/or reduce a particular area of an image while editing. The 
percentage of the zoom level will display in the title bar of the image, the status bar of Photoshop 
and the Navigator Palette.   
 

• The maximum zoom level is 1600%. 
•  Resize Windows To Fit option, when selected, will resize your window as you zoom in 

and out of an image.   When this option is not turned on, the window size will not change 
when zooming in/out of the image. 

• Ignore Palettes options, when turned on with the Resize Windows To Fit Options, will 
resize the image so that part of the image may be hidden behind the floating palettes. 

• Actual Pixels will change the zoom magnification to 100%. 
• Fit On Screen will resize your image to a window size that will not require scroll bars.   
• Print Size will provide a preview of the image based on its print size/resolution (Image, 

Image Size). 
 
Different Ways to Use the Zoom Tool on Your Own 
 

• Zoom In on an image by selecting the Zoom tool from the toolbox and clicking on the 
image.   Each click with the mouse will zoom in to the next preset zoom percentage.   

• Select the Zoom In tool from the View Menu and the image will zoom in to the next 
preset zoon percentage. 

• Access the shortcut key for Zoom In by pressing Ctrl  and the + (plus) key. 
• Users can switch to the Zoom tool while using any other tool in Photoshop by pressing 

and holding the  Ctrl + Spacebar and at the same time clicking on the area of the image to 
be zoomed in.  

• Zoom In or Zoom Out of an image by typing the zoom percentage in the Navigator 
Palette or the Status Bar. 

• Reset the Zoom Level to 100% by double clicking with the mouse on the Zoom Tool in 
the toolbox.   

• Reduce the zoom level one level at a time by selecting the Zoom Out from the View 
Menu.  

• Reduce the zoom level by using the shortcut keys Ctrl and the – (minus) key.   Press and 
hold the Ctrl key while pressing the – (minus) key repeatedly until you are at the 
preferred zoom level.    

• Reduce the zoom level by selecting the Zoom tool from the toolbox and pressing the Alt 
key while clicking with the mouse on the image. 

 
Navigating Around the Different Magnifications. 

• Use the Scroll Bars on the image window. 
• Navigate around the image by selecting the Hand tool from the toolbox and left-click 

with the mouse while dragging the Hand tool over the image.  
 
Tip:  Switch to the Hand tool while using a different tool by holding down the spacebar.  
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Creating Selections  
 
Selecting an area of an image allows you to isolate an area of an image that you want to work 
with. A dotted selection border, also called a selection marquee, indicates a selected area on an 
image.  The area outside the selection border is protected while you move, copy, paint, or apply 
special effects to the isolated area. 
 
When using the Selection tools use the Options Bar (new to Photoshop 6.0) to add, remove and 
intersect selections of an image.  The new Options Bar also has the Feathering tool readily 
available along with the anti-alias and Style Menu.   

 
 

 
Marquee Tool  
 
The Marquee tool is located in the upper right-hand corner of the toolbox.   
 
A Marquee is a selection.  Use the Rectangular Marquee tool to make a rectangular or square 
selection of an image.     Hold the Shift key down while using the Rectangular Marquee tool to 
draw a square selection.    
 
Tip:  Hold the Alt key down while drawing a Rectangular or Elliptical selection and the 
selection process will start in the center and move outwards. 
 
Use the Marquee tool by left-clicking with mouse on the canvas and dragging from one point on 
out and releasing the mouse when finished to close and display the selection.  
 
The marquee selection, the marching ants on the canvas, is a selection of pixels on the canvas.  
As long as the selection is still active on the canvas, where you see the “marching ants”, it can be 
moved.  Start by placing the mouse cursor inside the selection and left-clicking with the mouse 
and dragging the selection to a different area on the canvas. 
 
A selection can also be moved while actually drawing the selection.  Start by drawing an 
incomplete or partial selection.  Next, hold down the space bar while still using the Marquee 
tool, meaning the left-mouse button is still pressed down to make sure the Marquee tool is still in 
the “on” position, and drag your selection to a different area on the canvas and release the space 
bar when finished moving the selection, and continue to draw the selection.  Release the left-
mouse button to close or turn off and/or display the selection.   
 
 
Testing the behavior of a selection 
Any selected area on the canvas can be “effected”, meaning any modification applied to the 
image will only apply to the selected area of the image.   
 
To test the behavior of the selection, select the Paintbrush tool from the toolbox  and 
paint over and around the selected area of the 
canvas.  Notice that the paintbrush will only paint 
in the selected area of the canvas.   
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Not 
Feathered 

Feathered 
2 px 

 
Make an Object from a selection 
Start by drawing a selection on the canvas using the Marquee tool.  Fill the selection with a 
Foreground color by choosing Edit, Fill, select Fill with Foreground Color, and press Ok.   
 
Deselect the object by using the menu Select and choosing the Deselect option.  The shortcut key 
to deselect is Ctrl+D for Windows.  
   
Feather Option 
The Feather field option is located in the Options toolbar.   
Using the Feather option will blur or soften the edge of the selection.  The Feather option has a 
range between 0 and 250 pixels.  A setting of 0 would apply no feathering. 
 
 The Feather field options must be set prior to making a 
selection.  Click with the mouse in the Feather filed on the 
Options bar and insert the number of pixels to feather.   
 
The feathering will apply to the border on out and to the 
border in towards the center of the image.  Example, if the 
Feather field were set to 2px, then the border would blur or 
soften two pixels out from the border and two pixels in from 
the border. 
 
 
 
Defining the Marquee Styles 
 
 
Remember to specify a selection Style prior to making the actual selection.  The different Styles 
are listed below: 
 
Normal:  Click and drag to make a normal selection. 
 
Constrained Aspect Ratio:  Use the Constrained Aspect Ratio to set a height-to-width ratio. 
Enter values (decimal values are valid) for the aspect ratio. For example, to draw a marquee 
twice as wide as it is high, enter 2 for the width and 1 for the height.  
 
Fixed Size:  The width and height selection are set and defined in pixels.  Just click on the image 
and an area will be selected according to the fixed size. 
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Elliptical Marquee Tool   
 
The Marquee tool is located in the upper right-hand corner of the toolbox and is hidden behind 
the Rectangular Marquee tool.   
 
 
The Elliptical marquee tool works similar to the Rectangular marquee tool except that it makes a 
circular selection rather than a rectangular or square selection.   Hold the Shift key down while 
making the selection and the selection will be a perfect circle. 
 
Anti-aliased  
 
When using the Elliptical Marquee tool, you will have an option to Anti-Alias a selection.  When 
making a selection using the Anti-alased option, the edge of the selection will be smooth and 
soft.  When making a selecting with the Anti-alased tool turned off, then the outer edge of the 
selection will be jagged, not smooth. 
 
Tip:  The option to have anti-aliased doesn’t exist on the Rectangular Marquee tool because the 
selection always lands on a pixel so you won’ t have that soft edge going, but instead, an edge 
with a hard pixel all the way around the selection.   
 
 
Test the difference between Alias and Anti-aliased 
 
Make a selection using the Elliptical Marquee tool and be sure the Anti-alias option is selected in 
the Options Bar.   

 
 
 

 
Fill the selection by choosing Edit, Fill, and select the Use Foreground color option. 
 
Draw a second selection by first deselecting the Anti-aliased option in the tool bar.  Next, fill the 
selection by choosing Edit, Fill, use Foreground color. 
 
Notice the difference. 

 
 
 
 
 
 
 
 
 
 

Anti-Aliased    Alias 
Smooth Edge     Jagged Edge 
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Lasso Tools   
 
 
Use the lasso tools to create freeform selections.   
 
Tip:  Press the Shift+L shortcut keys to switch between all the available Lasso tools in the Lasso 
fly-out menu.  
 
 
Lasso Tool  
Use the Lasso tool to draw freehand around a portion of the image you want to select.  Left-click 
the mouse and trace the area of the image you want to select.   
 
Polygon Lasso Tool   
The Polygon Lasso tool is similar to the Lasso tool where it lets you make a freehand selection of 
the image.  However, the Polygon Lasso tool has an added feature where you can click on 
different points in your image to set corners.  Setting corners while making selections is 
sometimes easier then trying to drag the mouse around multiple corners. 
 
Magnetic Lasso Tool   
Click once to set the start point of the Magnetic Lasso tool and move the mouse along the edge 
of the image that you want to select.  No need to click and drag – just move the mouse.  Double-
click the mouse on starting point to close the selection. 
 
Tip: The Feathering options do not reset when making new selections.   
 
 
Magic Wand Tool   
The Magic Wand tool selects pixels based on the color of the pixel selected.  The Magic Wand 
tolerance has a tolerance setting between 0 and 255.   
 
A tolerance of 0 would select pixels next to the pixel selected and identical in color.  A tolerance 
of 255 would be the similar to a Select All.     
 
If trying to select a color in a specific area, then select the Contiguous option to restrict your 
color selection in that specific area where the pixels are touching.  Having the Contiguous option 
turned off will select the color where ever it appears in the image. 
 
Tip: Add to a selection by pressing the Shift key and clicking with the mouse in another area of 
the image that you want to add to the first selection.   
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Magic Eraser Tool 
 
The Magic Eraser tool is a great tool to use when trying to remove the background from an 
image.  The Magic Eraser tool erases by a color tolerance.  The lower the tolerance, the more 
precise the eraser seems to be when erasing.  If erasing on a layer, then the Magic Eraser tool 
will erase to the background color.  If erasing on the background layer, then the Magic Eraser 
tool will erase to transparency. 
 
Removing the Background of an image using the Magic Eraser Tool 
 
   

• Select the Magic Eraser tool from the toolbox.  This tool will be used to erase the white 
background on the Clock layer. 

 
 

 
 
 

• Select the layer from the Layers Palette that will be modified. 
 

• In this class example, the Clock layer with its white background is sitting on a transparent 
or checkered background. 
 

Set the Tolerance for the Magic Eraser tool  
 
§ Too low of a tolerance will leave a little bit of white around the clock. 

• Select 10 as the tolerance. 
• Notice the image. 
• Use the History Palette and remove the tolerance setting. 

 
§ Too high of a tolerance will remove part of the clock. 

• Select 50 as the tolerance. 
• Notice the image. 
• Use the History Palette and remove the tolerance setting. 

 
§ Set the Tolerance at 22. 

 
§ The area around the clock is now transparent. 

 
Using the Extract Tool 
 
There will be times when you want to omit the background from an image.  The Extract tool is 
perfect to use when you want to omit a solid or busy background. 
 
§ Open an image:   File, Open, extract.jpg 

 
§ In this example we only want the baby gorilla.   
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§ From the Filter Menu, choose  Extract 
 
Note:  Photoshop 6 users:  The Extract tool is located under the Image Menu. 
 
 

 
The extract tools are located in a toolbox on the left side of 
the Extract screen. 
 
 
 The tool options are located on the right side of the 
Extract screen. 
 
 
 
 
 

 
§ Select the Highlight tool from the toolbox and choose a 

color for the highlighter from the Tool Options.  The default 
color is Green. 

 
§ Select a Brush Size and highlight the edge of the image you 

want to extract. 
 
§ Optional:  Choose Smart Highlight if you are highlighting a well-defined edge.  This 

option will help you keep the highlighter on the edge of the image.   Note:  When using 
the Smart Highlighter the brush size does not matter because the highlighter will re-size 
automatically to cover the edge.  

 
§ When finished highlighting the selection, select the Paint Bucket from the extract tools 

and fill the selection by clicking with the mouse in the highlighted area.  Blue is the 
default fill color.   
 

§ Select the Preview button that is located above the Tool Options to view the extracted 
image. 

 
 
§ Select the Clean Up tool to remove any unwanted areas of the image 

that were not extracted.   
 
Tip:  Press the Alt-key while using this tool to insert part of the image that was extracted.   

 
§ Select the Edge Touch-Up tool to smooth out and select/deselect areas around the outline 

of the image that was extracted.   
 
§ Select the OK button when finished to extract the image.  Note:  all pixels outside the 

extracted object are erased to transparency. 
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Optional: Creating a Background for the Extracted Image 
 
§ Create a new canvas for the extracted image.   Choose  File  |  New  |  500 x 500 pixels, 

RGB,  and select white background. 
 
§ Select a Forest Green Foreground color and fill the canvas with the selected color. 

 
§ Apply the Clouds  filter from the Filter, Render  Menu.   

 
§ Copy the extracted image to the new canvas.  Select the Move tool and press the Alt-key 

while dragging the extracted image to the new canvas.   
 
Touch up the Image 
 
§ Touch up the Image using one or all of the following tools: the Eye Dropper, Clone 

Stamp, Healing Tool, Patch tool and the Paint Brush. 
 
 

 
Selecting with the Quick Mask Mode  
 
The Quick Mask Mode is a great tool to use when making a selection.  Once in the Quick Mask 
Mode, the Paintbrush tool will be used to select or deselect part of the image.   
 
 

• From the Toolbox select the Edit in Quick Mask Mode button.   
 

• Select the Paintbrush tool from the toolbox. 
o Tip:  Use the Zoom tool to help zoom in or out of an area when selecting 
o Tip:  Change the paintbrush size to fit the area being selected. 

 
• Notice the Foreground and Background color chips have changed to the default color of 

white and black. 
 

o Painting with the Foreground color of White will deselect 
o Painting with the Foreground color of Black will select 
o Use the double-edged arrow to toggle the Foreground color from White 

to Black 
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The default color for the Edit Quick Mask Mode is Red.  Sometimes the color Red is hard to use 
when selecting a portion of the image that is the same color.  To change the Quick Mask Mode 
Color, double click the Edit Quick Mask Mode button in the toolbox.   
 
A Quick Mask Options dialog box will display.   Click on the 
Color chip and select a new color for the Quick Mask Mode.   
 
When using the Quick Mask tools reset the Foreground and 
Background color chips in the toolbox to the default colors of 
Black and White.   
 
 

 
When finished selecting the area of the image exit the Edit Quick Mask Mode by click on the 
Edit in Standard Mode button that is located in the toolbox next to the Edit Quick Mask Mode 
button.   
 
 
  
The area displayed on the screen shows the selected area of the image.   
 
Tip:  Reverse the selection by choosing Select, Inverse. 
 
 
Saving the Selection  
 
Note:  This is only one of several ways to save a selection. 
 
 
Click on the Paths tab from the Layers Palette. 
Nothing is displayed at this point in the Paths Palette.   
 

Click on the arrow to the right of the Paths tab to display the Path 
Menu.       
 
From the Path Menu, select  Make Work Path.   
 
From the Make Work Path dialog box a Tolerance needs to be set for 
selection being saved as a Path. 
   
The smaller the tolerance the more accurate your selection will 
remain.  Use the default tolerance setting of  .5 pixels.   
 
The Paths Palette is dispalying the shape of your selection at this time.  The default Path Name 

is displaying as Work Path. 
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Save the Work Path with a name that relates to the selection. 
 
From the Paths Menu select the Save Path option. 
 
 
 
A Save Path dialog box will display. 

 
 
 
 
 
 

Type the name:   Zebra  and Press OK. 
 
 
Notice the Path Palette now displays the Path name as Zebra 
instead of Work Path. 
 
 
To display the selection at a later time: 
Select the Path from the Path Palette.  Open the Path Menu and choose Make Selection.  
The “marching ant” selection will display on the image. 
 
 
Note:  if the “marching ants” are not displayed around the zebra go to the Paths Menu and select 
Make Selection.   Insert a Feathering Radius of 2 or 3 pixels and  Press OK. 
 

• Select the Move tool from the toolbox.  
 
Copy the selection to another canvas 
 
Position the cursor in the selected area.  Press the Alt key and left-click with the mouse and drag 
the selection to a different canvas.   Notice the image of the Zebra is located on a separate layer.  
 
Scaling the image 

 
Transform an object by choosing   Edit, Transform, Scale. 

 
This puts a box around the object being scaled.  Position the cursor on a corner placeholder and 
hold down the Shift key while left- licking and dragging in to make the object smaller.  When 
finished transforming the object,  double-click with the mouse inside the Transform box.   
 
Moving a selection 
 
If an object is on its own layer, it can be moved with the Move tool.   
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More Selecting Options  
 

• Select all pixels on a layer within the canvas boundaries by choosing Select All, Ctrl+A, 
from the Select Menu. 

• Deselect a selected area of an image by choosing Deselect from the Select Menu. 
 
Tip:  If you are using the rectangular marquee, elliptical marquee, or lasso tool, click anywhere 
outside the selected area to deselect. 
 

• Reselect the most recent selection by choosing Reselect from the Select Menu. 
 


